Star Chromatography Workstation
Version 6

Data Acquisition with CP-2002/2003 Micro-GC Control

Operation Manual
Trademark Acknowledgment


Other brand and product names are trademarks or registered trademarks of their respective holders.
# Table of Contents

## Getting Started

- About this Manual ................................................................. 1
- Additional Manuals................................................................. 1
- Data Handling and Reports Operation Manual ......................... 1
- Data Handling and Reports Tutorial Manual ............................. 1
- Star Toolbar .............................................................................. 2
  - Elements of the Star Toolbar ................................................. 3
  - Application Buttons ............................................................ 3
  - Quick Link Buttons ............................................................ 4
  - Star Toolbar Options .......................................................... 4
- Starting System Control the First Time .................................... 5

## Configuring an Instrument

- Modules and Instruments Defined ......................................... 11
- Elements of the Configuration Screen ..................................... 11
- Setting Instrument Parameters ............................................. 12

## The Instrument Window

- Elements of the Instrument Window ....................................... 12
- Displaying the Micro-GC Status and Control Window ............... 13
- Configuring the Micro-GC Status and Control Window ............. 14
- Configuring the Real-Time Chromatogram Display .................. 14
- Documenting Module Information ....................................... 16

## Building Methods

- Overview .................................................................................. 19
- Using Star Assistant to Create a new Method ......................... 20
- The Method Builder Window ................................................... 23
- Editing a Method ..................................................................... 24
  - Method Notes ..................................................................... 24
  - Micro-GC Data Acquisition Settings ................................. 25
  - Post-run Processing .......................................................... 29
The Startup Method ....................................................................................................33
Editing Methods from the Micro-GC Status and Control Window ....................................................................33
Importing Method Sections ..................................................................................................................34
Deleting Method Sections ..................................................................................................................35
Printing the Method ..........................................................................................................................35
Password Protecting a Method ...........................................................................................................36

Injecting a Single Sample .................................................................................................................37
Using the Inject Single Sample Dialog Box ...................................................................................37
Specifying the Data File Name and Path .......................................................................................38
Specifying Per-Sample Data Handling Parameters ......................................................................39
Specifying a RecalcList .....................................................................................................................41
Monitoring the Status of the Run .......................................................................................................42
Using QuickStart ..................................................................................................................................43

Injecting Multiple Samples ..............................................................................................................45
Using a SampleList in System Control ...........................................................................................45
Specifying the Data File Name and Path .......................................................................................48
Specifying Per-Sample Data Handling Parameters ......................................................................49
Specifying a RecalcList .....................................................................................................................51
Changing Default SampleList Entries ..........................................................................................52
Monitoring the Status of Runs ..........................................................................................................52
Saving SampleLists for Later Use ......................................................................................................53
Using More Than One Method for Injections ................................................................................53
  Changing the Method in the SampleList ......................................................................................54
  Using the Sequence Window .........................................................................................................55

Automation File Editor ....................................................................................................................57
Accessing the Automation File Editor ..............................................................................................57
Editing or creating a RecalcList ........................................................................................................58
Editing or creating a SampleList .......................................................................................................60
Specifying the Data File Name and Path .......................................................................................62
Specifying Per-Sample Data Handling Parameters ......................................................................64
Specifying a RecalcList .....................................................................................................................65
Changing Default SampleList Entries ..........................................................................................66
Using More Than One Method for Injections ................................................................................66
Editing or creating a Sequence .........................................................................................................68
Getting Started

About this Manual

This manual describes the operation of the Star Chromatography Workstation when used with the CP-2002 and CP-2003 Micro GC and optional Star ADC Board for chromatography data acquisition. It covers configuring an instrument for data acquisition, building a method, and running samples. For post-run data handling, peak integration, and standard report generation, please refer to the Data Handling and Reports Operation Manual.

Additional Manuals

Other sources of information are available to help you get the most from this product.

Data Handling and Reports Operation Manual

This manual describes post-run and interactive data handling, standard report generation, and advanced application.

Data Handling and Reports Tutorial Manual

The tutorials provide a practical way to quickly learn how to perform basic tasks using the Star Chromatography Software. These Tutorials cover Star Workstation operation that is common to all instrument configurations.
Star Toolbar

Star Chromatography Workstation is a suite of applications for controlling chromatographs, collecting data from chromatograph detectors, and analyzing that data. The Star Toolbar provides quick and easy access to the Star Chromatography Workstation applications. When activated the Star Toolbar behaves very much like the Windows Taskbar. It can be docked on any of the four sides of the display screen and other Windows programs will not cover or go behind it when they are opened in full screen mode.

If the Star Toolbar is not already opened on your Star Workstation, you can start it from the Windows Start Menu.
Elements of the Star Toolbar

Application Buttons
- Used to monitor instrument status, perform automated injections, and perform batch recalculation.
- Used to view and edit instrument operation, data acquisition, and data handling methods.
- Used to review chromatograms, interactively edit data handling parameters, and recalculate results.
- Used to preview standard chromatogram and results reports.
- Used for offline editing of SampleLists, RecalcLists and Sequences.
- Used to generate standard reports for a group of Data Files by dragging and dropping them on the Batch Report Window.
- Used to set Star Workstation security options and passwords.

Other application buttons may be added to the Star Toolbar when you install additional Star Workstation Options, such as StarFinder, Star Custom Report Writer, Star SD, and Star DHA.
Quick Link Buttons

Most Recently Used Data File

Menu of operations that can be performed on the Most Recently Used Data File.

List of Most Recently Used Files

Most Recently Used Method

Menu of operations that can be performed on the Most Recently Used Method.

List of the Most Recently Used Methods

Star Toolbar Options

Menu of Star ToolBar configuration options and operations that may be performed.
Starting System Control the First Time

The first time that you use the Star Chromatography Workstation to control your instrument, collect chromatographic data and generate results, you must configure the System Control application. The System Control Configuration Window allows you to set the communication parameters for each of your chromatograph modules and to drag the various modules into Star Workstation instrument areas to match the physical plumbing arrangement of your modules. Once the instruments are configured in System Control, the configuration is stored and you only need to reconfigure System Control when you change the physical hardware configuration of your chromatograph modules.

Start by running System Control.

When System Control is started the first time, the Star Assistant Communication Configuration Wizard will appear to guide you through the setting of Serial communications and ADC Board I/O port addresses.
Read the description presented in the Star Assistant window and click on the Next button to advance to the next step. The first time the Star Assistant guides you through the setup of your ADC Board I/O addresses, you will get the following message:

Click on the OK button to let the System Control application search for any installed ADC Boards.
When System Control finishes searching for installed ADC Boards, you will see this screen.

Star Workstation Module number for the ADC Board at the specified I/O Address.

System Control finds all installed ADC Boards and indicates their addresses. 280 is the recommended base address.

Select the style that matches the S1 switch on your ADC Board.

ADC Board S1 switch settings for the specified I/O address. If an ADC Board was found, these settings will match the switch on the ADC Board. If the ADC Board was not found or is not installed, the S1 switch settings on the ADC Board should be set to match these.

Click on next to continue with the Star Assistant.

Upon completion of the ADC Board setup, you will be prompted to setup the COMM (serial) ports. You may have up to 4 COMM ports installed in your PC. In order for your Star Workstation to recognize your CP-2002 or CP-2003 Micro-GC, you will need to designate which COMM port is connected to your Micro-GC. The first screen in the Configuring Communications wizard will summarize the process for you.
Click on the Next button to obtain the Setup COMM Ports screen shown below.

Click on the down arrow next to the port associated with the micro-GC you are configuring and select the appropriate model number from the list of available serial devices. For instance, if you have a CP-2002 configured to COMM port 1, click on the down arrow for COMM1. Scroll down the list of devices and select the 2002. Repeat this process for any other Micro-GCs or other serial devices you wish to control with the Star Workstation. When you have finished, click on the OK button at the bottom of the screen. If you also have ethernet devices connected, you will have to configure those at this time as well. Follow the Star Assistant’s instructions for those devices.

When the Star Assistant finishes, you will be at the System Control Configuration Screen. Close System Control and proceed to configuring your Micro-GC.

If you are using either a CP-2002 or a CP-2003 Micro-GC you will have to put the Micro-GC into the remote mode. If you have not already turned on your Micro-GC, turn it on now. You will be presented with a welcome screen followed by a top level menu with the following layout:
Using the four arrow keys on the right side of the Micro-GC’s keypad, move the highlight from Method to System. Once System is highlighted, press the Enter key.

You will be presented with a screen that has the following entries:

If the Config .. selection is not highlighted, use the arrows to scroll to Config .. and press Enter. You will be presented with the following display:
Use the TAB key to move between lines in this display and the arrow keys to choose between the two selections on each line. Tab to the Remote line and select Remote (black dot between the parentheses). When Remote is selected, any other configuration items that you set will be ignored. Highlight OK and press the ENTER key. You will be taken back to the previous menu; press the ESC key to get back to the top level menu screen.
Configuring an Instrument

Modules and Instruments Defined

System Control communicates with hardware modules that are used to perform chromatography. When you group these modules together in System Control (and physically connect together any necessary cables and plumbing), they form an instrument. All modules in an instrument are synchronized to run on the same time base. A Micro-GC instrument will usually contain only the Micro-GC. You may configure two Micro-GCs in each instrument. System Control will synchronize both Micro-GCs to run simultaneously. They will function effectively as one Micro-GC.

Elements of the Configuration Screen

Instrument Parameters --
Instrument Name
Operator Name
Instrument status

AutoStart Module area. Place the Micro-GC Module icon in this box if you want the Micro-GC to provide the Start signal to the chromatograph. If the Micro-GC receives a Start signal from the chromatograph, do NOT put it in this box.

Click on this button to enter or change the Instrument Name, Operator Name, and Maximum allowable error count.

Modules that have logged in and are available for configuration into an instrument are displayed here.

Module icon showing that Micro-GC Module 28 has been configured to Instrument #1.

Instrument Window – drag modules from the available module area to add them to an instrument. Double-click in this area to view the System Control Status and Control Window for this instrument. For the Star Data Acquisition Workstation Single Instrument, there will only be one instrument window shown on this screen.
Setting Instrument Parameters

When the maximum number of non-fatal errors is exceeded during automation, the automation sequence halts. Setting this value to zero disables this feature.

You are optionally prompted for this information when you start an automated sequence of injections or recalculation.

The instrument name appears on reports and in the instrument window.

The operator name appears on reports.

The Instrument Window

Once you have configured your instruments, you may view any instrument window.

Double-click in this area or select the instrument from the Instrument menu to view the System Control Status and Control Window for this instrument.

The instrument window allows you to monitor the status of all modules assigned to the instrument, perform injections of one or more samples, and perform batch recalculation.
Elements of the Instrument Window

Instrument Status display shows Operator and Instrument Names, free disk space, connected modules, open method, and the number of injections, calculations, recalculations, and reports.

Quick Link button for the selected Data File.

List of the most recently used Data Files. Data Files are added to this list box as they are generated. When a Data File is selected, its name appears on the Quick Link button above. This Quick Link button provides access to additional operations for the selected Data File.

Micro-GC Status and Control Window

Real Time Chromatogram Displays

System Control Instrument Window positions are remembered the next time you start System Control.

Displaying the Micro-GC Status and Control Window

If the Status and Control Windows for the modules configured in the instrument are not currently displayed, you can select Show Module Windows from the Windows menu.
Configuring the Micro-GC Status and Control Window

Method parameters and synchronization signals can be configured in the ADC Board window.

Edit the active Method.

Show only the chromatogram display.

Enable or disable synchronization signals.

Configuring the Real-Time Chromatogram Display

All detectors installed on the CP-2002/2003 GC display their chromatographic signals in bunches or packets in real time. Configuration of the chromatogram display for all detectors is the same.

Enable/disable the Auto Scale feature.

Use these buttons to move between stored scalings.

Hide/unhide the Toolbar.

Set both the amplitude and time axes to full scale.

Set the amplitude axis to full scale.

Set the time axis to full scale.

Display the chromatogram for each channel one above the other (tiled mode).

Overlay the chromatograms for the two detector channels.

Select the background color for the display.

Enable/disable the cursor display.
GETTING STARTED

The Instrument Window

Drag an area of the display to view a more detailed section of the plot.

...or zoom in both axes by pressing and holding the left mouse button on the spot you wish to enlarge. (Holding the Control key down will allow you to zoom out.)

Adjust zero offset.

Adjust amplitude scale.

Adjust time scale.

Hide/unhide vertical amplitude scale slider.
Documenting Module Information

You may wish to document the configuration of your modules, their installation and most recent service dates, and other information pertinent to your instrument. To do so, use the Module Information Editor accessed from the Edit menu in the instrument window.

Select Edit Module Info.

Click on the module window to give it the focus.
The Module Information Editor window is displayed.

You may add and edit sections and items in sections.

The injections value is updated each time an injection is performed.

Select Help for details on creating and editing module information.

Click on Done to close the window.

Module information is copied into Data Files generated after injections and can be included in the Run Log portion of the results report.
Overview

In the Getting Started section, you configured your hardware for an instrument and opened the System Control Window for the instrument. At this point, you could simply inject a sample, as described in the following sections. However, it is not likely that the default Method will have the Method settings that are appropriate for your analysis. Therefore, the default Method will need to be edited to enter the settings appropriate for your analysis. Method Builder is used to view and edit Methods. It can be accessed from:

This button on the Star Toolbar opens Method Builder and prompts you to create a new Method or open an existing one.

This button on the System Control Toolbar allows you to view and edit the Method file shown on the button.

This button on the Star Toolbar allows you to view and edit the Method file shown on the button.
Using Star Assistant to Create a new Method

If you click on the Method Builder button on the Star Toolbar, you will get this dialog box.

If you choose Create a New Method File, the Star Assistant Wizard will guide you in building this new Method.
You will first be asked to select the instrument configuration for which you want to create a Method.

Select Custom to create a Method for an instrument that is not attached to the Star Workstation.

Select the Instrument for which this Method will be used.

If the instrument has more than one detector configured, all of the configured detectors will be shown here. You may build a Method for any detector or combination of detectors shown in this box.
For each detector in the Method, you will be asked to select the channels on which post-run processing will be performed.

When you have selected the data channels and type(s) of post-run processing to be run for each detector, the Star Assistant will create a Method containing all of the sections that are needed to control the hardware, collect data and do the post-run processing specified. These Method sections will contain default values for all of the parameters. These parameters will need to be edited to match your analysis.
The Method Builder Window

This navigation window shows the overall structure of the Method, its sections, and subsections. The branches can be expanded by clicking on the plus sign or contracted by clicking on the minus sign to show the desired level of detail.

The parameters window shows the parameters for the highlighted item in the navigation window. Method parameters are viewed and edited in this window.

Detailed information about the menu items and Toolbar buttons can be found in the on-line help.
Editing a Method

As you step down through the Method tree, the parameters associated with each section of the Method are displayed for editing.

Method Notes

The first item in the Method is the Method Notes section. Method Notes is a free form text field where information about the Method or the application can be entered. Method Notes are displayed in the File Open dialog boxes used whenever you select a Method.

Method Notes can help explain to the operator when a Method should be used. They can also be used to convey sample preparation information and reminders to refer to specific items in the lab's Standard Operating Procedures.
Micro-GC Data Acquisition Settings

The Micro-GC method consists of either two or three main sections depending on whether you have a CP-2002 or a CP-2003. Both Micro-GCs have a Set Conditions section and a Data Acquisition Section. The CP-2003 has, in addition, a Pressure Schedule section.
The Set Conditions section is divided into Channel A and Channel B settings that include Channel Preference (to either make the channel Active or Not Active), Column Preference (Setting the temperature limit to use either a high temperature column or a low temperature column), the Column's Temperature, Use of the TCD Offset, The channel Sensitivity, the Injection Time (set in multiples of 5 seconds), determine whether the Injector Heater (optional) is used, and set the Injector Temperature. Settings which can not be set independently include the Run Time, the Sample Time and the Stabilizing Time.
The Data Acquisition section contains only one setting, the Detector Bunch Rate. The data acquisition rate is based on a 100 Hz sampling frequency. Thus a Detector Bunch Rate of 1 will give 100/1=100Hz. A bunch rate of 2 will give 100/2=50Hz. Detector Bunch Rates and their corresponding Effective Data Rates are listed below:

<table>
<thead>
<tr>
<th>Detector Bunch Rate</th>
<th>Effective Data Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>2</td>
<td>50.0</td>
</tr>
<tr>
<td>4</td>
<td>25.0</td>
</tr>
<tr>
<td>8</td>
<td>12.5</td>
</tr>
<tr>
<td>16</td>
<td>6.3</td>
</tr>
<tr>
<td>32</td>
<td>3.1</td>
</tr>
<tr>
<td>64</td>
<td>1.6</td>
</tr>
<tr>
<td>128</td>
<td>0.8</td>
</tr>
</tbody>
</table>
Depending on the Detector Bunch Rate and the setting of an entry in the STAR32.INI file, you will get a fixed number of Detector Noise Monitor points from which the Noise value for the run is calculated. This Noise value is used by data processing to detect and quantitate peaks. You may always set a Noise value based on other criteria in the Integration Parameters page of the post run Data Handling section. The default setting of the MGCACQ entry in the STAR32.INI file is 0 which yields a Noise Monitor of 100 points for a Detector Bunch Rate of 1, a Detector Bunch Rate of 2 uses a Noise Monitor of 50 points, all other Detector Bunch Rates use a monitor of 25 points. If the MGCACQ entry is set equal to 1, then the Noise monitor is set to 50 points for all bunch rates except 1 where it remains at 100 points. If the MGCACQ entry is set to 2, all bunch rates will use a Noise Monitor of 100 points.

If you have a CP-2003 Micro-GC, you will have a third Method section labeled Pressure Schedule. Use the parameters in this section to define the Initial Pressure Interval (the length of time the CP-2003 will hold the initial pressure), the Initial Pressure, the rate at which the pressure will change, and the final pressure. The two pressure channels may be set independently. Each channel will have a button (View Actual Pressure Schedule) that, when selected, will display any deviations from the entered pressure schedule due to the Method End Time or other causes.
Multichannel detectors can have post-run processing sections for any or all of their channels. For the Method shown above, post-run processing has only been chosen for Micro-GC Channel A. The post-run processing for Channel A includes both Data Handling (peak detection and integration) and Standard Reports (numerical results and chromatogram).
The Data Handling section has parameter pages for Integration Parameters, Peak Table entries, Calibration Setup, Verification Setup and Time Events (integration control parameters). For the initial setup of a Method the default values are usually a good starting place. For information on these Data Handling parameters and setting them for your application, please refer to the Data Handling and Reports Operation Manual.

The Standard Reports section sets the parameters for the information that will be printed after Data Handling has been run. For a complete description of the Standard Report options, please refer to the Data Handling and Reports Operation Manual. Until you get comfortable using the Star Workstation,
you may want to always print the chromatogram and results (default options). To help identify the reports that are generated, you will probably want to give them a Method-specific title. To do so simply, click in the Title box and type in the title to be used on the chromatogram and results report pages.

The Results Format page controls the format of the results table, the result units to be printed in the Amount column header and the number of decimal digits to print for the calculated amounts. It also controls what additional information is appended to the end of the results report.
The Chromatogram Format page controls the formatting of the printed chromatogram. When the defaults are used, the chromatogram for the complete run will be printed and autoscaled to fit on one page. You may only want to print the portion of the chromatogram that contains the peaks of interest. This may be done by changing the start and end times to bracket the period of interest. Auto Scale is often turned off and a fixed attenuation and zero offset chosen so that printed chromatograms from several runs may be visually compared. For more information about the Chromatogram Format parameters, please refer to Data Handling and Operation Reports Manual.
The Startup Method

When you start System Control and display an Instrument Window, the last active Method for that instrument is activated. When System Control is started, it will return to the initial settings in the Method that was last used on the instrument.

To change Methods, simply click on the activate Method button on the System Control Toolbar or choose New Method from the File menu.

Editing Methods from the Micro-GC Status and Control Window

The Micro-GC Status and Control Window Method… button allows you to directly edit the active Method corresponding to that Micro-GC. When you click on this button, Method Builder is opened with active Method loaded and the corresponding Instrument Control section selected. You can then edit that section or any other section of the Method as described previously.

Once you have edited the Method and closed the Method Builder window, you are prompted to reactivate the Method. Reactivating the Method downloads the changes to the Micro-GC.
Importing Method Sections

You may wish to copy sections from one Method file to another. This can be done by opening the Method file that you want to edit in Method Builder. Then from the Method Builder File menu, select Import Section… The Import command prompts you to select the file containing the sections you wish to import.

Once you have selected the file, a dialog box of sections contained in the Method file is displayed. Highlight the sections that you wish to import by clicking on them. If you click on one section and the hold down the shift key while clicking on another section, all of the sections in between will be selected. Holding down the control key while clicking on a section will add that selection to those files already selected. Clicking on a highlighted section while holding down the control key will remove that section from the list of selected files.

When the desired sections have been highlighted, click on the Import button to import them into the Method being edited. If the Method already has sections with the same module address and channel ID, you will be prompted to reassign a new module address and channel number to the imported section or overwrite the existing section in the current Method.
Deleting Method Sections

To remove sections from a Method open the Method containing the sections you wish to remove in Method Builder. Click on the Delete Section button on the Method Builder Toolbar or select Delete Section from the File menu. A dialog box of sections contained in the Method file is displayed. Highlight the sections that you wish to delete by clicking on them. If you click on one section and the hold down the shift key while clicking on another section, all of the sections in between will be selected. Holding down the control key while clicking on a section will add that selection to those files already selected. Clicking on a highlighted section while holding down the control key will remove that section from the list of selected files.

When the desired sections have been highlighted, click on the Delete button to delete them from the Method being edited. You will be prompted to confirm that you want to delete each section before it is deleted.

Printing the Method

To print a Method from Method Builder, click on the Print button on the Toolbar and select the Method section or sections to be printed. The active Method can also be printed from the System Control Toolbar and the Star Toolbar. Click on the Active Method Options button on the System Control Toolbar or on the Method Operations button on the Star Toolbar and select Print Method.
Password Protecting a Method

A Method can be password protected from changes by clicking on the Set Password button on the Method Builder Toolbar or selecting Set Password from the File menu. Enter the password and then re-enter it to verify that it was not mistyped. After a Method has been password protected, the password will be required to save changes to the Method.

Once a Method is password protected, it can be activated and used for instrument control and data acquisition. It can also be viewed from Method Builder. Only the saving of changes to the Method will be inhibited unless the correct password is entered.
Injecting a Single Sample

By now you should have your instrument configured and a basic Method built for data acquisition. If this hasn’t been done, please refer to the previous sections for instructions on doing this.

Using the Inject Single Sample Dialog Box

You can inject a single sample from System Control by using the Inject Single Sample dialog box.

Display the Inject Single Sample dialog by selecting it from the Inject menu …

or by clicking on the Inject Single Sample button on the toolbar.
The Inject Single Sample dialog box is displayed.

Enter notes about the sample.

Specifies the number of injections of this sample.

Refer to the Specifying Data Handling Parameters section of this manual.

Enter information about the sample.

Click Inject to start the run.

Select the Method to use for the run.

Change the location and name of the Data Files.

The fields in the table change depending on the type of sampling device configured in the instrument.

---

**Specifying the Data File Name and Path**

Data File names can be up to 255 characters long. Sample ID, injection date, module name, and injection number can be embedded in the file name making the Data File name correlate with each sample injection. When you click on the Data Files… button, the Data Files Generation dialog box is displayed. This dialog box allows you to select the path and the file name specification for the data file displayed.

The left side of the Data File Generation dialog box allows you to select the drive letter and subdirectory (path) where the data files are to be stored. The default directory is the data subdirectory of your Star directory.
INJECTING A SINGLE SAMPLE
Specifying Per-Sample Data Handling Parameters

The right side of this dialog box allows you to create a file name specification. You can combine text entry with the “%” variable symbols shown to specify file names that contain sample injection specific information. An example of the file name is dynamically updated as you type in the file name specification. This makes it easy to see how a Data File created with this file name specification would appear.

Specifying Per-Sample Data Handling Parameters

Most Data Handling parameters are specified in the Method used during the injection. Some parameters may vary on a per-sample basis, and are therefore specified when you perform the injection.
The following Data Handling parameters can be specified on a per-sample basis:

- Unidentified Peak Factor
- Multiplier
- Divisor
- Amount Standard when one Internal Standard is being used

Refer to the Data Handling and Reports Operation Manual for a brief description of these parameters.

Refer to the Regulatory Compliance Manual for a complete description of how these parameters are used to calculate results.

Not only can you specify these parameters on a per-sample basis, but you can specify them on a per-detector channel basis. This is useful if, for example, you have an ADC Board with channel A and channel B connected to two different detectors on a GC. In addition, if you are using multiple internal standards, you can also specify their amounts on a per sample and per detector channel basis.

To access these extended Data Handling parameters, click on the button in the Multi-Channel Multi-Standard column in the Inject Single Sample dialog box. The Data Handling Channels dialog box is displayed. When you select the detector channel to in the Data Handling Channels dialog box, the calculation type, internal standard peaks and amounts are read from the active Method. Be sure the Method you will be using is already active before you enter detector-specific parameters.
Specifying a RecalcList

You can choose to create a new RecalcList, append to an existing RecalcList, or not create or update a RecalcList. To select the RecalcList option that you want, click on the RecalcList button. The RecalcList Generation dialog box is displayed.

If you choose to create a new RecalcList, this automatically generated RecalcList will not overwrite an existing RecalcList unless you also specify “Overwrite the Recalc List each time the SampleList begins”. If a RecalcList with the same file name exists, the newly created RecalcList will have number appended to its file name to make it unique and to prevent the older RecalcList from being overwritten.
Monitoring the Status of the Run

After an injection is performed, the status of the run can be monitored in the instrument window.

Module status is shown in the status and control windows and on the toolbar.

The total number of injections completed is shown in the Instrument Status window.

Automation actions and errors are logged in the Message Log.

The chromatogram is displayed as it is acquired.
When you double-click on the status bar at the bottom of the instrument window, the entire Message Log window is displayed.

All Message Log entries are stamped with the time they occurred.

Using QuickStart

QuickStart is a fast way to inject a single sample without having to use System Control directly. QuickStart can be customized and is ideal when setting up instruments for routine use. Refer to the on-line help in QuickStart for further details.
QuickStart first starts System Control and waits until all modules have logged in. When ready, the QuickStart window is displayed.

Choose the instrument for the injection.

Enter information about the sample.

Enter the name of the Method you wish to use.

Enter sampling information. This information is specific to the type of sampling device installed.

Refer to the on-line help for more details on the QuickStart screen.

Press Start to begin.

Enter the name of the stand-by Method. This Method is downloaded to the modules after the run is complete, and is used to specify the stand-by state of the instrument.
Injecting Multiple Samples

By now you should have your instrument configured and a basic method built for data acquisition. If this hasn’t been done, please refer to the previous sections for instructions on doing this.

Using a SampleList in System Control

You can inject multiple samples from System Control by using the SampleList.

Choose to open either a New SampleList or an existing SampleList from the File menu...

...or by clicking on the New or Open Automation File button on the toolbar.
The SampleList window for the open SampleList is displayed. It contains fields that are specific to the sampling device configured in the instrument. In this case, since there is no sampling device configured, a generic SampleList is used (no vial positions or sampling options).

Spreadsheet columns can be sized by dragging their border using the left mouse button. Move columns by dragging them using the right mouse button. Right click on column headers for formatting options.

Enter information about the samples and the injections you wish to perform.

Select the location and name for the Data Files generated by the SampleList.

Used to specify RecalcList generation options.

Press the Begin button to start injecting samples.

Enter notes about the sample.

Enter post-run operations to be performed.
When the table is scrolled to the right, the Sample Name column doesn’t scroll so you can easily tell for which sample you are entering additional parameters. Commonly used data handling parameters, the amount for single internal standard calculations, the unidentified peak factor, a multiplier, and a divisor, can be entered directly into this table.

If you have more complex requirements, such as multiple internal standards or multiple detectors requiring different entries for these data handling parameters, click on the button in MultiChannel MultiStandard column.

If you need to add several similar lines to the sample list, click on the Add Lines… button. You can then enter the common information in the dialog box.

For sequentially numbered Sample names, enter the starting number and the number of entries to add to the SampleList. The Sample Names will have these numbers appended to them.
When you press the Begin button, you are prompted for the Method to use.

Enter the Method to use for the run…

…or browse for the Method file.

After you click on OK, the run will begin. If you are using a manual injector or a sampling device that is not controlled by the Star Workstation, you will need to start the device manually.

**Specifying the Data File Name and Path**

Data File names can be up to 255 characters long. Sample ID, injection date, module name, and injection number can be embedded in the file name making the Data File name correlate with each sample injection. When you click on the Data Files… button, the Data Files Generation dialog box is displayed. This dialog box allows you to select the path and the file name “specification” for the data file.
The left side of the Data File Generation dialog box allows you to select the drive letter and subdirectory (path) where the data files are to be stored. The default directory is the data subdirectory of your Star directory.

The right side of this dialog box allows you to create a file name “specification”. You can combine text entry with the “%” variable symbols shown to specify file names that contain sample injection specific information. An example of the file name is dynamically updated as you type in the file name specification. This makes it easy to see how a Data File created with this file name specifications would appear.

Specifying Per-Sample Data Handling Parameters

Most Data Handling parameters are specified in the Method used during the injection. Some parameters may vary on a per-sample basis, and are therefore specified when you perform the injection.
The following Data Handling parameters can be specified on a per-sample basis:

- Unidentified Peak Factor
- Multiplier
- Divisor
- Amount Standard when one Internal Standard is being used

Refer to the Data Handling and Reports Operation Manual for a brief description of these parameters.

Refer to the Star Workstation Regulatory Compliance Manual for a complete description of how these parameters are used to calculate results.

Not only can you specify these parameters on a per-sample basis, but you can specify them on a per-detector channel basis. This is useful if, for example, you have an ADC Board with channel A and channel B connected to two different detectors on a GC. In addition, if you are using multiple internal standards, you can also specify their amounts on a per sample and per detector channel basis.

To access these extended Data Handling parameters, click on the button in the MultiChannel MultiStandard column in the SampleList. The Data Handling Channels dialog box is displayed. When you select the detector channel to in the Data Handling Channels dialog box, the calculation type, internal standard peaks and amounts are read from the active Method. **Be sure the Method you will be using is already active before you enter detector-specific parameters.**
**Specifying a RecalcList**

You can choose to create a new RecalcList, append to an existing RecalcList, or not create nor update a RecalcList. To select the RecalcList option that you want, click on the RecalcList button. The RecalcList Generation dialog box is displayed.

If you choose to create a new RecalcList, this automatically generated RecalcList will not overwrite an existing RecalcList unless you also specify “Overwrite the Recalc List each time the SampleList begins”. If a RecalcList with the same file name exists, the newly created RecalcList will have number appended to its file name to make it unique and to prevent the older RecalcList from being overwritten.
Changing Default SampleList Entries

When you add a new row into a SampleList, default values are used for each cell. To change the default values, click on the Defaults… button in the open SampleList window. The following dialog box will be displayed. Enter the desired default values and click on Save.

| Sample Name | Sample Type | Cal. level | Injection Notes | Autolink | Amount Standard | Unit Peak Factor | Multiplier | Device | MultiChannel
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Sample</td>
<td>Analysis</td>
<td>1</td>
<td>none</td>
<td>none</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>none</td>
</tr>
</tbody>
</table>

Monitoring the Status of Runs

The status of the run can be monitored in the instrument window. Status is disabled during the Monitoring Sampling and Running states. The chromatogram will update, however. Status will again be displayed after the run completes. Note that an actual value that is out of tolerance will be displayed in red while values within tolerance are blue.

Module status is shown in the status and control windows and on the toolbar.

The total number of injections completed is shown in the Instrument Status window.

Automation actions and errors are logged in the Message Log.

The chromatogram is displayed as it is acquired.
INJECTING MULTIPLE SAMPLES
Saving SampleLists for Later Use

When you double-click on the status bar at the bottom of the instrument window, the entire Message Log window is displayed.

<table>
<thead>
<tr>
<th>Time</th>
<th>Instrument</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>17:42:04</td>
<td>1</td>
<td>Single Sample Automation Began</td>
</tr>
<tr>
<td>17:42:04</td>
<td>1</td>
<td>Activating Single Sample Test Sample</td>
</tr>
<tr>
<td>17:42:34</td>
<td>1</td>
<td>Method Method Builder Demonstration Method, nist activated</td>
</tr>
<tr>
<td>17:42:34</td>
<td>1</td>
<td>Results will appear to new RecalcList RECALCULATION LIST</td>
</tr>
<tr>
<td>17:52:42</td>
<td>1</td>
<td>Data file test sample 1 run created for &quot;test sample&quot;, injection 1.</td>
</tr>
<tr>
<td>18:03:06</td>
<td>1</td>
<td>Data file test sample 1001 run created for &quot;test sample&quot;, injection 1.</td>
</tr>
<tr>
<td>18:03:06</td>
<td>1</td>
<td>ADCB.15 Ch A Data Handling. No peaks</td>
</tr>
<tr>
<td>18:03:22</td>
<td>1</td>
<td>Completed 1 Inject Actions for Test Sample with 1 Errors</td>
</tr>
<tr>
<td>18:03:22</td>
<td>1</td>
<td>Completed 0 AutoLink Actions for Test Sample</td>
</tr>
<tr>
<td>18:03:22</td>
<td>1</td>
<td>Completed 0 New Calibration Block Actions for Test Sample</td>
</tr>
<tr>
<td>18:03:22</td>
<td>1</td>
<td>Completed 0 Calibration Block Report Actions for Test Sample</td>
</tr>
<tr>
<td>18:03:22</td>
<td>1</td>
<td>End of Automation reached.</td>
</tr>
</tbody>
</table>

All Message Log entries are stamped with the time they occurred.

Saving SampleLists for Later Use

When you make changes to the open SampleList, the changes are automatically saved to the SampleList file and will be used for the automated runs that are in progress. If you want to edit a SampleList other than the open SampleList, use the offline Automation File Editor application described in the next section of this manual.

Note: Opening an automation file, SampleList, Sequence, or RecalcList, during automated runs will cause the automation that is in progress to be suspended.

Using More Than One Method for Injections

The Star Workstation allows you to perform automated injections using more than one Method. There are two ways in which this can be accomplished. The first is by changing the active Method from within the SampleList. The second is by using a Sequence.
Changing the Method in the SampleList

You may change the Method used during injections by activating a Method in a SampleList row.

Select Activate Method from the Sample Type cell.

Click on the AutoLink button. The Activate Method dialog box is displayed.

Enter the name of the Method to use…

…or pick the Method from a list of files.
Using More Than One Method for Injections

When this line is encountered during automated injections, the specified Method is activated.

You may specify any number of Methods to be used in the SampleList.

### Using the Sequence Window

The Sequence window allows you to specify multiple Methods and SampleLists to be processed during automation.

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>Sample Type</th>
<th>Cal Level</th>
<th>Ini.</th>
<th>Injection Notes</th>
<th>AutoLink</th>
<th>Amount</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Run #1</td>
<td>Analysis</td>
<td></td>
<td>2</td>
<td>none</td>
<td>none</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Test Run #2</td>
<td>Analysis</td>
<td></td>
<td>2</td>
<td>none</td>
<td>none</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Test Run #3</td>
<td>Analysis</td>
<td></td>
<td>2</td>
<td>none</td>
<td>none</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Test Run #4</td>
<td>Analysis</td>
<td></td>
<td>2</td>
<td>none</td>
<td>none</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Test Run #5</td>
<td>Analysis</td>
<td></td>
<td>2</td>
<td>none</td>
<td>demo1.23</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Choose to open either a New Sequence or an existing Sequence from the File menu...

...or by clicking on the New or Open Automation File button on the toolbar.
The Sequence window for the open Sequence is displayed.

Enter the Method and SampleList to use. You may enter any number of Sequence lines.

Choose the action to be done in each step of the Sequence from the drop down box.

Press Begin to start automation.

Browse for a Method or Sample/RecalcList file in the active cell.
Automation File Editor

The Automation File Editor is used for editing and creation of automation files, SampleLists, RecalcLists, and Sequences offline (outside of Star Workstation’s System Control application). The Automation File Editor allows access to these files without disrupting automated runs that may be occurring in System Control. *SampleLists and Sequences that are active and running in System Control can not be accessed simultaneously in the off-line Automation File Editor.*

Accessing the Automation File Editor

Click on the Automation File Editor icon on the Star Toolbar.
Editing or creating a RecalcList

Choose either a New RecalcList or Open an existing RecalcList from the File menu...

...or by clicking on the New or Open Automation File button on the toolbar.

The RecalcList window for the open RecalcList is displayed. It contains most of the same fields contained in the SampleList. Where the SampleList may contain AutoSampler and sample specific data handling information, the RecalcList contains the Data File name and data file specific data handling information. The fields that are common to both the RecalcList and the SampleList are described in the sections following the creation of the SampleList.
As the table is scrolled to reveal additional columns, the Data File and Sample Name column do not scroll. They remain visible so that you can see for which data file and sample you are entering parameters.

Spreadsheet columns can be sized by dragging their border using the left mouse button. Right-click on column headers for formatting options.

Enter postcalculation operations to be performed.

Enter notes about the recalculation of the Data File.

Click here to enter extended data handling parameters.

Provides quick access to the Standard Report for viewing the results.
Editing or creating a SampleList

Choose either a New SampleList or Open an existing SampleList from the File menu...

...or by clicking on the New or Open Automation File button on the toolbar.

After choosing the SampleList to open the “Select SampleList Section Type” dialog box is displayed. This dialog box allows you to choose a SampleList that is appropriate for the AutoSampler that will be used. The Star Data Acquisition Workstation does not include AutoSampler control, therefore Generic is the only available choice.
The SampleList window for the open SampleList is displayed.

Spreadsheet columns can be sized by dragging their border using the left mouse button. Right-click on column headers for formatting options.

Enter notes about the sample.

Enter post run operations to be performed.

As the table is scrolled to reveal additional columns, the Sample Name column does not scroll. It remains visible so that you can see for which sample you are entering parameters.

Enter information about the samples you plan to inject.

Select the location and name for the Data Files generated by the SampleList.

When the table is scrolled to the right, the Sample Name column doesn’t scroll so you can easily tell for which sample you are entering additional parameters. Commonly used data handling parameters, the amount for single internal standard calculations, the unidentified peak factor, a multiplier, and a divisor, can be entered directly into this table.

If you have more complex requirements, such as multiple internal standards or multiple detectors requiring different entries for these data handling parameters, click on the button in MultiChannel MultiStandard column.
If you need to add several similar lines to the SampleList, click on the Add Lines… button. You can then enter the common information in the dialog box.

For sequentially numbered Sample names, enter the starting number and the number of entries to add to the SampleList. The Sample Names will have these numbers appended to them.

### Specifying the Data File Name and Path

Data File names can be up to 255 characters long. Sample ID, injection date, module name, and injection number can be embedded in the file name making the Data File name correlate with each sample injection. When you click on the Data Files… button, the Data Files Generation dialog box is displayed. This dialog box allows you to select the path and the file name “specification” for the data file.
The left side of the Data File Generation dialog box allows you to select the drive letter and subdirectory (path) where the data files are to be stored. The default directory is the data subdirectory of your Star directory.

The right side of this dialog box allows you to create a file name "specification". You can combine text entry with the "%" variable symbols shown to specify file names that contain sample injection specific information. An example of the file name is dynamically updated as you type in the file name specification. This makes it easy to see how a Data File created with this file name specifications would appear.
Specifying Per-Sample Data Handling Parameters

Most Data Handling parameters are specified in the Method used during the injection. Some parameters may vary on a per-sample basis, and are therefore specified when you perform the injection. The following Data Handling parameters can be specified on a per-sample basis:

- Unidentified Peak Factor
- Multiplier
- Divisor
- Amount Standard when one Internal Standard is being used

Refer to the Data Handling and Reports Operation Manual for a brief description of these parameters.

Refer to the Regulatory Compliance Manual for a complete description of how these parameters are used to calculate results.

Not only can you specify these parameters on a per-sample basis, but you can specify them on a per-detector channel basis. This is useful if, for example, you have an ADC Board with channel A and channel B connected to two different detectors on a GC. In addition, if you are using multiple internal standards, you can also specify their amounts on a per sample and per detector channel basis.

To access these extended Data Handling parameters, click on the button in the Multi-Channel Multi-Standard column in the Inject Single Sample dialog box. You will be prompted for the Method that will be used when this SampleList is run. Then Data Handling Channels dialog box is displayed. When you select the detector channel in the Data Handling Channels dialog box, the calculation type, internal standard peaks and amounts are read from the Method that you just selected. The values entered for internal standard peaks and amounts will be entered into the peak table of this method.
An amount may be entered for each internal standard peak in the Method.

Select specific detector channels here (up to 4).

Use these buttons to edit the corresponding sections of the active Method.

**Specifying a RecalcList**

From the SampleList RecalcList... button, you can choose to create a new RecalcList, append to an existing RecalcList, or not create nor update a RecalcList. Clicking on the RecalcList button displays the RecalcList Generation dialog box.

![RecalcList Generation dialog box](image)
If you choose to create a new RecalcList, this automatically generated RecalcList will not overwrite an existing RecalcList unless you also specify “Overwrite the Recalc List each time the SampleList begins”. If a RecalcList with the same file name exists, the newly created RecalcList will have number appended to its file name to make it unique and to prevent the older RecalcList from being overwritten.

Changing Default SampleList Entries

When you add a new row into a SampleList, default values are used for each cell. To change the default values, click on the Defaults… button in the open SampleList window. The following dialog box will be displayed. Enter the desired default values and click on Save.

Using More Than One Method for Injections

The Star Workstation allows you to perform automated injections using more than one Method. There are two ways in which this can be accomplished. The first is by changing the active Method from within the SampleList. The second is by using a Sequence.

You may change the Method used during injections by activating a Method in a SampleList row.
Using More Than One Method for Injections

Click on the AutoLink button. The Activate Method dialog box is displayed.

Enter the name of the Method to use…

…or pick the Method from a list of files.

When this line is encountered during automated injections, the specified Method is activated.

You may specify any number of Methods to be used in the SampleList.
Editing or creating a Sequence

Choose either a New Sequence or Open an existing Sequence from the File menu...

…or by clicking on the New or Open Automation File button on the toolbar.

The Sequence window for the open Sequence is displayed.

Enter the Method and SampleList to use. You may enter any number of Sequence lines.

Browse for a Method or SampleList file in the active cell.

Choose the action to be done in that step of the Sequence from the drop down box.